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OBSERVING AND QUANTIFYING BEHAVIOR 
Today you will conduct focal sampling and continuous recording using the 
Jwatcher software package. This tool may be useful for independent projects.  
 
While the second week of this lab will familiarize you with Jwatcher, the first week 
will be spent researching different hypotheses that could be tested, and 
establishing a protocol for behavioral observations to test one hypothesis.  
 

 There will be both male and female crickets. 
 Crickets can be starved for 24 hours prior to lab (requires pre-planning). 
 Crickets could be paired 24 hours prior to observations (requires pre-planning). 
 Morphological data (total body length, cerci length, ovipositor length, antennae 

length, pronotum width) may be collected. 
 Additional objects could be added to the arena. 
 Cricket sounds can be played or recorded. 
 Any compounds needed for pharmacological manipulation must be ordered. 

 
PART 1 – DESIGNING THE EXPERIMENT (week 1) 
1A) Use Web of Science through the Reed College Library website to identify 
primary literature regarding cricket behavior and develop a hypothesis to be 
tested.  
1B) Create an EndNote library from Web of Science for efficient referencing. 
1C) Observe the crickets & develop an ethogram. 
1D) Develop your hypothesis & an experimental plan to test it. 
1E) Set up your animals for your experiment. 
 
 
PART 2 – RECORDING BEHAVIOR (week 2) 
2A) Familiarize yourself with JWatcher’s workflow and file structure. 
2B) Create the files necessary to record behavior. 
2C) Perform the planned experiment and record behavior. 
2D) Create files necessary to analyze your data. 
2E) Analyze and summarize your data. 
 
PART 3 – OPTIONAL -  ADVANCED ANALYSES 
If you are interested, look into the sophisticated analyses that can be done. 
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1.A.) WEB OF SCIENCE, GENERAL INSTRUCTIONS 
1. Working with your partner, go to the Reed College Library Website 

(http://library.reed.edu/) 
2. From the Find menu select Articles, etc (databases). From there 

select “W” and select “Web of Science” 
3. Generate a list of words to describe the behaviors you are interested to 

study in crickets. The more specific the terms, the more restricted the 
search will be. It is OK to begin very broad. 

4. Choose a few of your key words and type them into the space for “Topic” 
and click “Search”  

 
 
5. The search strategy can use Boolean Logic terms AND & OR.  
6. By default, the articles are sorted according to publication date with the 

most recent first, but you can also sort by times cited etc. 
7. When beginning a new research topic, it 

can be useful to find a review article. Use 
the “Document Types” menu to refine 
your search to include only reviews. 

8. By clicking on the title of this article you can 
read the article abstract as well as other 
information about the article to help determine if it is relevant. 

9. If this is a paper you want to read, click the “Check Reed Journals” 
link to see if Reed has online access to this article. 

10. If the word “Article” appears in the Content available section, you can 
use that link to access the article immediately. 

 
 
11. If the library does not have access to this journal article (perhaps it does 

not have a subscription or perhaps the subscription does not cover those 
years) you can “Request from ILL”.  

12. Find a few articles on your topic that are available online  
13. Either download the .pdf file or open the .html version in your browser.  
14. Also, save the citation to your EndNote library (see next section) you will 
use these to design your experiment. 
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1.B.) ENDNOTE, GENERAL INSTRUCTIONS 
15. In Web of Science, any citation that you want to download to EndNote 

must first be add added to the “marked list” by checking the box near the 
word “Title”. 

16. Web of Science keeps track of how many citations you have marked. 

17. When have finished searching for articles export your citations by going to 
the “Marked List” page.  

18. Here, select the EndNote button on step 3 

 
19. These citations should automatically be saved to your download folder. 
20. Move the downloaded document (ends with .ciw)  
21. Open EndNote by clicking the icon in the dock or application 

folder.  
22. From the File menu, select New.  
23. In the popup window, name your new library and Save it in a logical 

location. 
24. Use the File menu and select Import… 
25. Use the popup window to navigate to the 

downloaded file (ends with .ciw)  
26. Be sure that “Import Options:” is set to Web of 

Science (ISI). 
27. When you click Import, the citations you found 

should populate the endnote library.  
28. In Word, you can add citations to your protocol 

document or write up. 
29. When you get to a point for a citations in your 

text, navigate to EndNote & highlight the appropriate ciation in the library. 
30.  
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31. Return to your word document.  
32. From the Tools menu, select EndNote X3 > and choose Insert Selected 

Citation(s). 
33. The citation will be inserted in your word document wherever your cursor 

is. 
34. The full citation will also be added at the end of your document.  

35. The intext citations 
are highlighted in 
grey when your 
cursor is in them. 

36. You can change the 
format of the citations 
and reference list. 

37. Each Journal uses a 
different style  

38. There is no “correct” style, and the biology department is not picky about 
what style you use, but you must be consistent. EndNote will ensure that 
your citations style is consistent. You can change between styles easily. 

39. Go to the Tools menu and select EndNote X3 and choose Format 
Bibliography. 

40.  Use the Which output style: option to select the 
style you want. If you don’t see the one that you 
want, use the Browse button to see all of the 
formats that are currently available to you.  

41. If you are curious to know more about EndNote 
Web please consult with Linda Maddux, Reed 
College’s Science librarian. 

 
 
 



Bio342_Animal_Behavior   
 

 
 5 of 19 

 

1C) OBSERVE CRICKETS AND DEVELOP AN ETHOGRAM 
In order to move from questioning to conducting research one must make 
preliminary observations and formulate hypotheses. These are actually two 
intimately connected steps, it is likely that you will return to web of science (Part 
1A) and download additional citations (Part 1B) as you observe animals (Part 1C) 
and formulate your hypothesis (Part 1D) or as you develop an experimental plan 
(Part 1E) to test that hypothesis.  
 
 
1. Observe the group housed crickets using ad libitum recording. (This means 

that there are no constraints on what is recorded when. You simply note 
whatever is visible and “seems” relevant.) 

2. Can you tell which are males and which are females? 
3. Can you identify individual crickets based on morphology? 
4. Can you differentiate aggressive behavior and courtship behavior? 
5. After you feel familiar with general cricket behavior, develop an ethogram. 

You may also need to relie on descriptions from the articles you read earlier. 
 
An ethogram is a catalogue of behaviors described by neutral postures and 
recognizable movements. Ideally, an ethogram should include objective 
descriptions that are not subject to observer interpretation. The particular 
ethogram used in any study will depend upon the question that is being 
asked, and also on how accurately, and with what specificity, a particular 
behavior can be scored. Your ethogram should be tailored to the experiments 
you plan to do. 

 
a. Describe behaviors using objective language. 
b. Categorize behaviors using quantitative measures. 
c. Avoid anthropomorphism and inference. 

 
Your ethogram need not include all behaviors that a cricket may potentially 
display. Your ethogram need not even include all of the behaviors that crickets 
display in this staged interaction. Your ethogram should include all behaviors that 
may be relevant for testing your specific hypothesis. Spend a few minutes 
discussing with your lab partner, and consulting the primary literature. Record 
your ethogram in your lab notebook. 
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1D) DEVELOP YOUR HYPOTHESIS AND EXPERIMENTAL PLAN 
Biological hypotheses are provisional and testable explanations for observed 
phenomena. (These are what motivate scientists in their career.). Biological 
hypotheses give rise to specific questions that are testable by observation or 
experimentation. Making preliminary observations (Part 1C) is a critical part of 
formulating a good hypothesis. Formulating hypotheses is a creative process, 
requiring imagination as well as knowledge. While a period of unfettered 
preliminary observation is often important, the observation period must be 
supported with background research (Part 1A) to ensure validity and relevance of 
the hypothesis. 
Experimental hypotheses, more often called “alternative hypotheses” usually 
describe the experimental result that would allow a research to reject the null 
hypothesis. These hypotheses pertain to a specific testable question that may 
support the biological hypothesis. (These may motivate a scientist to go to work 
today.) 
Statistical hypotheses use data to make decisions. An experimental result is 
called statistically significant if it is unlikely to have occurred by chance alone, 
according to a pre-determined threshold probability, the significance level. The 
null hypothesis typically corresponds to a general or default position (random 
assortment, lack of association etc.). (While strongly emphasized in Introductory 
Biology courses, these hypotheses are not highly motivating to most scientists.) 
 
1. Working with you partner, based on your reading and your observation, 

develop a biological hypothesis. This may actually be a hypothesis that 
extends beyond crickets to include aggression, or mate choice in general. 

2. Write one paragraph to state your hypothesis and provide supporting 
evidence from the literature (use endnote to format your citations Part 1B). 

3. Working with your partner and based on your reading, describe one 
experiment involving observation of cricket behavior that is relevant to your 
biological hypothesis. (Read ahead so that you understand the type of 
data to be collected with JWatcher.) 

4. Write a few sentences to explain the experiment and what results would 
support your hypothesis.   

For example: 
“In order to test the hypothesis that …(succinct biological 
hypothesis)., we …(brief experiment description).. with crickets. If 
…(experimental hypothesis)… the data would support this 
hypothesis.” 

(TURN THIS IN, BY SAVING IT ON THE SEVER BEFORE YOU LEAVE LAB!) 
5. In you lab notebook, write up a protocol for the experiment that you will 

conduct next week.  
6. Remember to include negative controls (talk with Suzy or the TAs if you are 

unsure about this.) 
7. Consider how the animals will be housed for the week. 
8. Consider how many animal will be tested in each condition. 
9. Consult the articles that you read to make sure these details are realistic. 
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1E) SET UP ANIMALS FOR THE EXPERIMENT. 
Your planned experiment likely includes one or more experimental paradigms as 
well as the control group. You will NOT be able to do the full experiment in one 
class period. Instead, plan to do one experimental observation and one control 
observation. 
 
1. Working with your partner, collect the animals that you will need for your 

experiment.  
2. Take some extra animals so that you can still do an experiment if some of 

them die. 
3. The animals can be housed in opaque or clear take-away food containers. 
4. Seal the containers well, using tape to eliminate gaps. 
5. The animals MUST be provided with water. 
6. Animals may optionally be provided with food. 
7. Animals may be housed individually or in groups. 
8. You may use males or females. 
9. You must make a plan to check on your animals to ensure that they have 

water (and food). 
 

 
 
 
 
For the behaviors you plan to observe, consider whether: 
Are all behaviors mutually exclusive, or can your organism be doing two things at 
once? 
Are all behaviors discrete events, or are they states (such as "resting")? 
Are some behaviors modifiers of other behaviors? (such as aggression which 
might be "modified" by an intensity score) 
Are there behaviors that change their meaning in a conditional fashion?  (such as 
an aggressive display when an animal is in its own territory on in another 
territory) 
Are you interested in behavioral sequences or transitions? 
Are you interested in the interval between behavioral events? 
Are you interested in the lag time between two specific behaviors? 
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PART 2 – RECORDING BEHAVIOR 
Today you will use an event recorder to quantify the behavior of your chosen 
organism. Event recorders are computer programs (or dedicated pieces of 
hardware) that record keystrokes as they occur over time. In our case, 
keystrokes will represent behavioral transitions.  For instance, when your animal 
is foraging, you might type an "f", when your animal is grooming, "g", etc. 
 
We will use an event recorder called JWatcher to score your experiments. The 
JWatcher program includes some analysis algorithms along with the power of the 
event recorder. With these tools, you will be able to calculate not only the number 
of events but also the time allocated to each of the behaviors in your ethogram.  
This can be used to obtain an accurate time budget. The full JWatcher program 
and manual is available in class or on-line at:  www.jwatcher.ucla.edu. 
 
2A) BECOME FAMILIAR w/ JWATCHER WORKFLOW AND FILE STRUCTURE.  
This chart describes JWatcher work  flow.  
By the end of lab today you will: 
1) Create a Global Definition File (*.gdf) which 
will serve as the “ethogram” and assign keys 
to each behavior. 
2) Create a Focal Master File (*.fmf) 
which includes the behaviors (or a subset 
thereof) from the global definition file.  This file 
also instructs JWatcher to prompt users for 
additional data about each observation during 
data collection.  
3) Record behavior. The data file (*.dat) file is 
created automatically during each 
observation.  It contains the additional notes 
about the observation as well as the raw data 
that you have recorded.   
4) Create a Focal Analysis File, which specifies how data files (.dat) will be 
analyzed and specifies the results to be reported. 
5) Quantitatively analyze each *.dat file to produce a results file (*.xx.res) that 
can be opened in Excel.  JWatcher is capable of, summarizing several data files 
(*.rsm), quantifying conditional behaviors, testing observer reliability, and 
performing complex analysis (behavior combinations, sequence analysis, 
transitions matrices, Markovian analysis), some of which you will explore today. 
 
As you work on the computer today, remember to use your lab notebook as a 
record of the steps you take, the names of the computer files that are generated, 
your ideas, new hypotheses, or difficulties that you encounter. 
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2B) CREAT JWATCHER FILES NECESSARY TO RECORD BEHAVIOR. 
2B1) Defining your Ethogram in JWatcher 
Based upon the written ethogram you have developed you will "define" a 
JWatcher ethogram.  Some people prefer to use logical key locations, others 
prefer to use logical letters that match the behavior description.  Confer with 
your partner and decide on a code. You will have a chance to practice and can 
change the code later. 

1. In the Applications folder, find the JWatcher_V1.0 folder and double 
click.  Now double click on the JWatcher icon (black square, with a gold J 
and gray W) to launch the JWatcher program. 

2. When JWatcher first opens, you will be in the Data Capture tabbed 
window.  Click on the Global Definition tab to change windows.  The 
Global Definition window is where you will specify your ethogram by 
assigning key codes to each behavior. 

3. The Global Definition window is divided into two sections: one to define 
behaviors and another to define modifiers.  We will be defining behaviors 
only. 

4. Click on the Add row button in the top section to begin assigning key 
codes to behaviors.  

5. It is up to you and your partner to choose the key strokes that correspond 
to each behavior. You may use only one single character per behavior.  
Try to choose something intuitive and easy to remember, such as a for 
aggression and f for forage, etc.  Note that JWatcher is case sensitive:  f 
will NOT be recorded the same way as F.  Because it is difficult to switch 
between upper and lower case, for this exercise, use lower case letters. 
Record the letters that you choose for each behavior in your lab notebook. 

6. Type in the single character code in the Key Code box. Then either tab or 
click into the adjacent Behavior box to type in the corresponding behavior.  
You may also include a more lengthy description of each behavior in the 
Description box but remember to avoid anthropomorphisms or “intent” in 
your descriptions whenever possible. 

7. Click on the Add row button to continue adding each behavior. 
8. When you are done adding all your behaviors, click the Save button in the 

lower right corner of the window. 
9. To Save your new Global Definition file to the desktop click the house icon 

in the upper right part of the Save As window.  Now double click on the 
Desktop folder icon for local user. Name your file by typing into the File 
Name: box in the lower part of the window.  The extension .gdf will 
automatically be added when you click Save (this stands for Global 
Definition File). 

NOTE: When starting a study, it is often difficult to decide how many and which 
behaviors to record.  Your global definition file may include behaviors that you do 
not end up using in your observations or in your analysis.  For now, include all 
behaviors that you think you might want to quantify. 
NOTE: Generally it is good to include a key code for "out of sight" and also 
one for "other".  Think about why these are important categories. 
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2B2) CREAT JWATCHER FILES NECESSARY TO RECORD BEHAVIOR. 
Specifying Focal Details for a JWatcher Observation Project 
Based upon your global definition file you will now create the "focal master file" 
(.fmf).  This file specifies what data (behaviors, and additional information) will be 
collected during each focal observation. 

1. Click on the Focal Master tab at the upper left to change windows. Be 
careful, as it is right next to Focal Analysis Master. You may find yourself 
in the Test Details page (see bottom left tabs).  If so, change pages by 
clicking on the Define Codes tab. 
 

2. The Define Codes page shows the ethogram to be used when scoring 
data for this particular project.  Currently it should be blank.  
 

3. To import your pre-existing ethogram from your .gdf file, click on New 
(bottom center of the window) and a new selections window will open.  
You should see your .gdf file that you just made. If not, you will have to 
navigate back to the desktop by clicking the house icon and then the 
desktop icon. Select your global definition from the list in the top part of 
the window. Click Open to load your ethogram. If you decide not to use 
specific behaviors in your global definition file, use the delete_row button 
to eliminate those.  While JWatcher allows you to add rows here, it is 
important to remember that your global definition file is you recorded 
ethogram with the concise behavioral description. It is good practice to 
keep the focal master file consistent with the global definition file and 
make any required changes directly to your .gdf file. For good record 
keeping, the .gdf file should not be saved under the same name if it is 
changed, rather use a new name (ver1.1 or the date). 
 

4. Next, using the lower left tabs, change to the Test Details page.  You will 
score each staged interaction for the same amount of time.  In the 
Duration boxes, type 0 in the hours (HH) box, and the number of minutes 
(MM) box, and 0 in the seconds (SS) box. If you expect the interactions go 
be of varying lengths set the time to the maximal amount of time.   
 

5. Finally, in the lower left tabs, change pages again by clicking on 
Questions. This window is where you may define the variables that will be 
associated with each focal sample file, such as individual ID, age, sex, 
time of day, name of observer, location (if you are in the field), etc.. For 
today, you will decide what information you want associated with your raw 
data. You may specify up to 6 questions. 
 

6. Click Save As to save your Focal Master File. Again, the proper file 
extension for a Focal Master File (.fmf) will automatically be added for you 
when you click Save. 
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2C) PERFORM THE PLANNED EXPERIMENTS AND RECORD BEHAVIOR. 
When your animals are set and you are ready to begin scoring behavior.  
Change windows by clicking on the Data Capture tab (upper left).   

1. Click on the file navigator icon in order to name the data file you will be 
creating.  

2. Type in the name of your new file dat_exp_initials_datetime in the File 
Name box and click Open.  Keep the names simple. (Jwatcher 
sometimes has problems with long names and spaces in names so 
try to keep file names short and use underscores for spaces) 

3. Specify your Focal Master File by clicking on the file navigator icon Select 
ing your .fmf file and clicking Open.  

4. Click the Next button at the bottom right to tab into the next page. 
5. Answer the questions by typing into the box below the question and click 

the next button to advance.  
6. Click the Next button. 

If you wish to see a list of the behavioral codes on your computer screen, click 
the Behaviors box in the upper right corner of the JWatcher screen. 

7. You should be looking at the JWatcher – Data Capture window. 
8. You are now ready to start your first staged interaction. Gently introduce 

your two crickets to the arena. 
9.  Click the Start button in the center of the Data Capture page.   
10. Immediately type the key code representing the behavior the focal subject 

is currently engaged in.   
11. Whenever the behavior changes, type the key code for the new behavior. 
12. JWatcher will time out at the time specified in your focal master file or you 

can end the recording.  
13. JWatcher will automatically save your data in the .dat file that you named 

If you made a data entry mistake, look at the timer and make a mental note of it. 
You can fix it later.   

14. Stage a second interaction but have your partner record the behavior. 
15. give the new data file a new name that ties it to the second interaction. 

 
If you made mistakes while recording behavior you should have noted those 
errors in your lab notebook when they occurred.  It is always good practice to edit 
your data immediately after scoring while the details are fresh in your mind. Use 
your lab notebook to indicate which errors have been corrected. 

10. Click on the Edit Data tab. 
11. Use the Open button to select the *.dat file that contains errors. 
12. On the Key Codes tab you can Insert Rows, Delete Rows, edit the time 

(with elapsed (ms) or Time) and change key codes. 
13. Save your data file. 

 
Based on your difficulty here, you might decide to add, subtract or change key 
codes for research. In reality, you would expect to go through several iterations 
of observation, recording, and analysis before settling on the most appropriate 
protocol. 
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2D) CREATE FILES TO ANALYZE BEHAVIORAL DATA WITH JWATCHER  
Once you have scored a few observation periods, you are ready to use 
JWatcher's analysis algorithms. Analyzing data files can be a complex process 
and it is necessary to carefully think through the relationships between the 
different behaviors you have recorded (in reality it would be best to do this after 
collecting “pilot data” before collecting a lot of data).  One strength of JWatcher is 
that you can re-analyze behavioral data in many different ways.  
 
Basic Analysis (For today, read, but do not execute, steps in grey.) 
For a basic analysis you must first create a file called a focal analysis master 
file (*.faf)  

1. To create a focal analysis master file, click on the Focal Analysis 
Master tab in the upper left menu.   

2. Click on the New box, at the bottom center.   
3. Load your project’s ethogram by choosing the same focal master file that 

you used to capture data. Select your *.fmf file and click Open. 
4. Change tabs by clicking on the States tab at the bottom. States are 

behaviors that occur over time. Some states are mutually exclusive (such 
as eating and sleeping). This will greatly affect the time budget 
calculations. Only behavioral states that are mutually exclusive will stop 
the timer for the previous behavior. Use the check boxes to specify which 
behaviors will turn each other off. 

5. Click on the State Analysis tab (Note: there is also an Analysis tab above 
and a States tab below, you want State Analysis). If you are interested in 
creating the most accurate time budget for the interaction, it is appropriate 
to use "all durations", however if you are interested in precise timing of 
behaviors it is most appropriate to select "natural duration" (this will be 
explained in lab, or in the manual). If you are interested in the interval 
between specific behavioral states or events you will also select one of the 
interval options. While it is possible to select all options and calculate all 
measures you may choose to run analyses separately in order to keep 
output files to a manageable size. If your cricket was out-of-sight for some 
part of the observations, then JWatcher can correct for this by calculating 
the proportion of time in sight. 

6. The Event Analysis tab allows you to specify which behaviors should be 
counted as an instantaneous event, these will be counted but will not 
contribute to the proportion of time, thus they will not be a part of a time 
budget. JWatcher permits a behavior to be simultaneously analyzed as an 
event and also a state.  

7. When you are done, click on the Save As button. Specify the location to 
save your new focal analysis file. Again, the proper file extension .faf will 
automatically be added. 

8. The Summary button will open a text window containing all the 
specification in the current focal analysis master file (*.faf).  JWatcher will 
provide "warnings" for any parameters that are likely to cause problems.  

 



Bio342_Animal_Behavior   
 

 
 13 of 19 

 

2D optional THE FOLLOWING STEPS EXPLAIN SOME OF THE OTHER 
TABS, THESE WOULD BE DONE BEFORE STEP 8 ABOVE. 
1. Open to the Time tab. This is where you determine the time during which 

behavior is analyzed. If all of your observations are exactly the same 
duration, and you always start recording at the beginning of the 
observation you can use the default "Score from the beginning of the 
session".  However, if it takes ~ 10 seconds to start recording, you may 
want to use a Fixed offset.  Or you may want to start from the first 
behavior recorded, or you may want to start the analysis with a specific 
behavioral event (such as awake).  The "Time bin duration" specifies 
how the observation period will be subdivided. (0 means the entire 
observation period is one bin).  Time bins might be useful if you were 
studying a response over time after a specific treatment. They may also 
be useful if your observation periods are not a standard duration. 

2. Look at the Exclusions tab. This is where you could decide to ignore 
some of the behavioral events that you recorded, but be careful, this can 
produce erroneous results if you do not adjust the mutually exclusive 
behaviors accordingly.  Here you can also subtract certain behaviors from 
the time budget calculation (for example you may choose to subtract all of 
the time that an animal was asleep and create a time budget only for 
awake behaviors). Likely you will ignore this for today. 

3. The Conditional States tab allows you to specify combinations of 
behaviors as simultaneous streams. These behaviors cannot be mutually 
exclusive behaviors (as defined in the States tab). Conditional states are 
indicated as "a|b" which provides the statistics for a the state "a" given that 
"b" is already on. You can specify  "   a|b|c   " and Jwatcher will calculate 
both the proportion of time that "a" is on given that both "b" and "c" are 
both on and also the proportion of time that "a" and "b" are on given that 
"c" is on. (a more clear explanation will be given in lab if you are interested 
in this type of analysis for your observations).  

To define conditional states you can either: 
a. Add row and type your condition  
               or  
b. click Conditional states to see non-mutually exclusive  states. 

4. The Conditional Events tab is similar to Conditional states except that 
the first behavior must be an event rather than a state, and therefore a 
"rate" can be calculated (see Events tab). Again you can only use non-
mutually exclusive behaviors. (Likely these conditional analyses are 
beyond the scope of your behavioral observations today but the goal is to 
appreciate the complexity of behavioral analysis that is possible). 
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2.E) ANALYZE AND SUMMARIZE YOUR DATA 
2.E.1) JWatcher allows analysis of files one at a time or batch processing. 
1. To generate results files, click on the Analysis tab.  
2. Use the file navigator icon open your *.faf file.  
3. Use the file navigator icon to select your *.dat data file to analyze.  
  OR 
      Use the folder navigator icon to specify an entire folder with multiple *.dat  

files to be analyzed with batch processing. 
4. Specify the Desktop to save the results file by clicking on the folder icon and 

then click Open (note: this file is automatically created and named, you are 
just verifying that you know where it will be placed. However you can give the 
folder a name that is more informative than simply "results"). 

5. Select the Print results for all behaviors button. This ensures that all of your 
output files have uniform layout even if all behaviors did not occur. 

6. Click the Analyze button at the bottom of the file window. 
7. If you get a warning message telling you that there were unrecognized key 

strokes in your file.  These will be ignored. 
8. Notice that JWatcher creates a log file. This is akin to a lab notebook. It will 

be saved in the same folder as your results files.  
 

You can use Excel to view the results files.   
There are two results files, *.cd.res, and *.tr.res.   
The *.cd.res file has quantitative results. The *.tr.res is not useful for most 
analyses.   
 
View the *.cd.res file by opening it through Excel.  Excel will NOT automatically 
recognize JWatcher files; you will need to tell Excel do it.  The *.cd.res file is a 
comma delimited text file. (ask if you need help.) 

 
Once opened, you should see a list of the behavioral codes and several 
summary statistics for each behavioral code.  
 
Each of your result files will relate to just one of your observations. 
 
If your cricket never went out-of-sight, then proportion of time and proportion of 
time in sight should be the same. The proportion of time in sight for your 
behaviors is the time budget. 
 
It is a good idea to check your results files and familiarize yourself with their 
contents before going on to more sophisticated analyses. JWatcher includes 
several algorithms for summarizing and quantifying behavioral data, however, in 
your own research you may want to perform statistical tests that are not a part of 
the JWatcher package and you would use these results to do that.  For analysis 
outside of JWatcher it may be necessary to reformat results either by cutting-
and-pasting in Excel or using your own computer script (possibly written in 
PERL). This is beyond the scope of today's lab. 
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2.E.2) Summarizing Analysis Results 
JWatcher includes algorithms to provide summary statistics for the analyzed 
result files. You may want summarize subsets of your observations, for example 
you might want to summarize the results for females separate from males, or 
experimental animals separate from control animals. 
1. Click the Summarize Results tab. 
2. Select the folder containing your results files to be summarized. All files to be 

summarized MUST have been analyzed using the same focal analysis master 
file (.faf) 

3. Choose a file name and folder for the summary.  
4. Generally, Analyze Results in Rows provides a format that is easiest to 

work with in excel. 
5. Choose the appropriate summary statistics 
6. Click Summarize Results Files. 
7. The resulting file is a comma delimited file that can be opened in Excel. 
8. Use this file to make graphs, or figures that are informative regarding your 

hypothesis. A pie chart works well for a time budget, though a bar graph 
allows you to include error bars.  It is up to you to present you data in the 
most informative and effective format. 

9. Briefly record your conclusions (if any) in your lab notebook. 
 
2.E.3) 
1. Working with you partner, open you document from last week. 
2. Based on your experience today, write a one paragraph description of the 

methods that you used. This should be an accurate representation of what 
was done.  
It should include: 
• a brief description of any equipment used,  
• information about how the animals were housed,  
• actual sample size that was tested and  
• citation of any relevant articles from which you drew methods.  

3. Do not worry about statistical analysis! 
4. Briefly describe the results and include at least one figure with an accurate 

figure legend. 
5. In this document, state whether or not your results support you biological 

hypothesis and explain why (or why not). 
 
(TURN THIS IN, BY SAVING IT ON THE SEVER BEFORE YOU LEAVE LAB! 
Be sure that all the name of every member of the group is on it) 

also 
The following items should be saved by each student team in a folder on 
the courses server (it is ok to zip them together and upload one file)  

a global definition file (.gdf)  
a focal master file (.fmf) 
a focal analysis file (.faf)  
all raw data files (.dat) 

result files (cd.res)  
the summary (.rsm) 
the endnote library 

 


